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第一章 背景 
 
近年，ARM プロセッサが急速に広まっています．さらに、ARM9，ARM11，ARM-M，Cortex といった新たなアーキテクチャが

次々と発表されています．これらの新しいプロセッサでは、従来から存在したARMが拡張され、さらにARM9とARM11が追加され

ました． 

 

本書では、従来から広く利用されているGNU クロス開発ツールを、これらの最新アーキテクチャ/命令セットへ対応させます．最

新版のGNU ツールを実際に使って、対応したクロス開発環境を作ります． 

 

組込アプリを開発する際に、2点は非常に重要です。一つは統合開発環境（IDE）となり、もう一つはデバッグ環境です。いろんな

統合開発環境ツールがありますが、無料で使用できるオープンソースEclipseプラットフォームはJava アプリを含めて、C/C++ア

プリを開発用の全世界共通のIDEです、今後、ますます多くの使用者が増えていきます。なお、デバッグツールはオープンソース

Open-On-Chip Debugger(OpenOCD)という便利ツールがあります。 

 

Open-On-Chip Debugger(OpenOCD)は、システムプログラミングにおけるデバッグと埋め込まれた対象装置がないかどうかテス

トされる境界走査を提供することを目指します。 

 

OpenOCDのGDB と接続するためにOpen JTAG コネクトを使う必要です。ただし、パラレルJTAGの転送スピードが遅いので、

本書はカスタマイズ化のOpenJTAGを利用し、Eclipse、OpenOCDなどオープンソースとあわせて、ARMシリーズ開発を行います、

例えば、ARM基板からダウンロード、書き込み、デバッグを行います。 

 

GDBは以下の基板をデバッグできます。 

① ARM7(ARM7TDMIとARM720t) 

② ARM9、(ARM920t、ARM922t、 ARM926ej-s、ARM966e-s) 

③ XScale(PXA25x、IXP42x) 

④ Cortex-M3(LM3とST STM32)  

http://www.csun.co.jp/�


株式会社日昇テクノロジー 
 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp 5 

第二章 ARM シリーズ開発の仕組み・イメージ 
 
組込開発のよいプラットフォームは基本的に４つモジュールを含まれます。 

① 統合開発環境：IDE（Integrated Development Environment）、例えばEclipse 

② クロスコンパイラツールチェイン（Cross Complier tools chain） 

③ リモートデバッグツール（例：OpenOCD、Open On-Chip Debugger） 

④ 開発用のパソコンとARM基板のコネクタ（JTAG） 

全体のイメージは下記の図です。 
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第三章 用意するもの 
 
以下は Windows 用です。 

 

3.1 ソフトウエアダウンロード URL： 

 

弊社のサーバーから全て必要のものを一括ダウンロードできます。 

http://www.dragonwake.com/download/open-jtag/openJTAGIDE.zip 

中身に、下記内容を含まれます。 

ソフトウエアリスト（名前をクリックしてからツールもそれぞれダウンロードできます） 

＊解凍先：お好きな場所を選べられても OK（例：D:\tmp） 

 

01.arm-2009q1-161-arm-none-eabi.exe 
02.openocd-0.1.0.msi 

03.yagarto-bu-2.19.1_gcc-4.3.3-c-c++_nl-1.17.0_gi-6.8.50_20090311.exe 

04.yagarto-tools-20070303-setup.exe 

05.Cygwin 

06.jre-6u7-windows-i586-p.exe 

07.eclipse-cpp-galileo-win32.zip 

 

 

3.2 OpenJTAG 用のデバイス(jtag デバッガ、弊社で販売しているもの) 

 

3.2.1 Open-JTAG の購入 URL： 

http://www.csun.co.jp/SHOP/200905191.html 

 

3.2.2 デバイスダウンロード URL： 

http://www.dragonwake.com/download/open-jtag/open-jtag-driver.zip 
①usb-driver(OpenJTAG 用の USB ドライバ) 

＊解凍後：D:\tmp\open-jtag-driver 

3.3 本書使用サンプルソースコード 

http://www.dragonwake.com/download/open-jtag/gcc_openjtag_eclipse_arm_example.zip 

*解凍後：(D:\OpenJTAG\ gcc_openjtag_eclipse_arm_example) 

1. 「config」：OpenOCD 用の設定ファイル 
2. 「lpc2148」：LPC2148 ボード用のサンプル 

3. 「lpc2388」：LPC2388 ボード用のサンプル 

4. 「stm32」：stm32FX103 ボード用のサンプル 

5. 「mini2440」：mini2440 ボード用のサンプル 
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第四章 インストール手順 
 
4.1 OpenJTAG のドライバをインストールする 
OpenJTAG をパソコンの USB ポートに挿入して、下の通りにドライバをインストールしてください。 
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USB ドライバのインストールは３回があります。インストール完了すると、デバイスマネージャで三つのデバイスが見えます。 
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※ OpenJTAG は USB シリアルポートとして使えます。 
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4.2 ソフトウェアをインストールする 
 
順番で以下のソフトウェアをインストールしてください 

01.arm-2009q1-161-arm-none-eabi.exe(EABI を持ってコンパイラ) 
02.openocd-0.1.0.msi(jtag デバッガ用ソフト) 

03.yagarto-bu-2.19.1_gcc-4.3.3-c-c++_nl-1.17.0_gi-6.8.50_20090311.exe(gcc) 

04.yagarto-tools-20070303-setup.exe(各種ユーティリティ) 

05.Cygwin 

06.jre-6u7-windows-i586-p.exe(Java) 

07.eclipse-cpp-galileo-win32.zip(Eclipse) 

メモ：①もしバージョン 1.4.2 以上の JRE を既にパソコンにインストールされたら、 

06 番の JRE のインストールが不要です。 

   ②05 番の eclipse を解凍して OK、インストール不要 

 

ダウンロードしたインストールファイルは「D:\tmp\openJTAGIDE」に格納されます、本書に全てソフトウエアは「D:\embeded」にイ

ンストールされます。 
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4.2.1 「arm-none-eabi.exe」をインストール 
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「Next」をクリックすると、インストールが始まります、インストール完了までに何分がかかります、完了までにお待

ちください。 
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4.2.2 「openocd」をインストール 
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「Install」をクリックすると、インストールが始まります、インストール完了までに何分がかかります、完了までにお待ちください。 

 

「Finish」をクリックし、OpenOCD のインストールが完了です。 
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4.2.3 「yagarto」をインストール 
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「Install」を押下、インストール完了まで何分がかかります。 
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4.2.4 「yagarto-tools」をインストール 
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「Install」を押下、インストール完了まで何分がかかります。 
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4.2.5 Cygwin のダウンロード＆インストール 
1 インストール 

a) setup.exe の DL＆起動 

http://cygwin.com/より setpu.exe をダウンロードし起動てください。 

直接ダウンロードしたファイルを起動しても OK。 

以下に注意すべき画面を中心に解説します(より詳しい手順は Cygwin のページを参照したください)。 

b) テキストファイル形式の選択 
以下の「Default Text File Type」に「Unix」を選びます(テキストファイルが UNIX 形式(改行が LF)となりま

す)。また Cygwin をインストールするマシンをサーバーとして利用したい場合には、「Install For」で「All Users」
を選びます。 
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c) パッケージ選択 

パッケージ選択の画面にて Category の「All」を「Install」に変更する。この変更によって全パッケージがインストールさ

れることになる 

 
 
上記の設定が終われば「次へ」をクリックすれば、ダウンロード＆インストールが始まる。 
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2 インストール後の設定 

a) ホームディレクトリの作成 

通常、デスクトップにできた Cygwin アイコンをクリックすると、/usr/username がホームディレクトリになるが、Windows の環境変

数 HOME が設定されていれば、Cygwin においてもそこがホームディレクトリとなる。この問題を避けるために、コントロールパネ

ルの「システム」 を起動し、「詳細設定」タブの下にある「環境変数」をクリックする。そしてユーザ環境変数に HOME 変数が設定

されていれば削除する。 

ここでデスクトップの Cygwin アイコンをクリックすればホームディレクトリが自動的に作成される。 

次にホームディレクトリの下に各種設定ファイルを編集していく。利用する漢字コードによって設定方法が異なるので、以下では

SJIS 環 境を説明する。設定するファイルは、.bash_profile、.bashrc、.inputrc、.vimrc の４つで(全てのファイルはピリ オドから始

まるファイルで隠しファイルとなっており、"ls -a" にて確認できる)、以下に示した通りに設定する。既に存在するファイルについ

ては追加し、存在しないファイルについては新規作成する。またファイルの編集 は TeraPad などのエディタを利用すれば便利。

注意点として、新規ファイルを保存する際には、「ファイル」→「漢字・改行コードを指定保存」を選び、改行コードに「LF」を選んで

保存してください。 

b)SJIS 環境に関わる４つファイルの設定 

i).bash_profile 

export TERM=vt100 

export LANG=ja_JP.SJIS 

export LESSCHARSET=japanese-sjis 

ii).bashrc 

alias ls='ls --show-control-chars --color=auto' 

alias ct='cygterm &' 

function ie { 

echo /cygdrive/c/Program\ Files/Internet\ Explorer/IEXPLORE "$(cygpath -w $PWD)\\$1" 

/cygdrive/c/Program\ Files/Internet\ Explorer/IEXPLORE "$(cygpath -w $PWD)\\$1" & 

} 

上記の ie 関数を設定しておくことにより、XML や XMLtable ファイルをコマンド上から起動可能になる。 

例) ie dat.xt #dat.xt を InternetExplore を利用して表示する。 

iii).inputrc 

set convert-meta off 

set input-meta on 

set output-meta on 

iv).vimrc 

set encoding=japan 

set fileencodings=sjis 

http://www.csun.co.jp/�
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4.2.6 「jre」をインストール 
   一般のソフトウエアと同じようにインストールします。もしバージョン 1.4.2以上の JREを既にパソコンにインストールされたら、

インストールが不要です。 

 「06.jre-6u7-windows-i586-p.exe」あるいはダウンロードした JRE インストールファイルをクリックし、「D:\Embeded\JRE」にイ

ンストールする 

4.2.7 「Eclipse」をインストール 
   「07.eclipse-cpp-galileo-win32.zip」あるいはダウンロードしたファイルを「D:\Embeded」解凍 
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4.3 ソフトウエアインストール後の動作確認 
確認方法：「スタート」→「ファイル名を指定して実行」→「cmd」を入力 

4.3.1 OpenOCD の確認 
確認コマンド：openocd –v 
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4.3.2 コンパイラ確認 
1：GCC コンパイラ「make」確認 

確認コマンド：make --version 
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2：ARM EABI「arm-none-eabi-gcc」確認 

確認コマンド：arm-none-eabi-gcc --version 
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3：ARM コンパイラ「arm-elf-gcc」確認 

確認コマンド：arm-elf-gcc --version 
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4.JRE バージョン確認： 

確認コマンド： 

java -version 
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第五章 Eclipse の設定 
5.1 Eclipse を起動する 

 
最初に Workspace の場所を聞いてきます。デフォルトは名前が長いので、"D:\embeded\eclipse\workspace"に変更しました。 
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画面の Workbench をクリックします。 

 
 

注意:サンプルを簡単に導入できるように、ダウンロードして前章で解凍してできた 

「D:\OpenJTAG\gcc_openjtag_eclipse_arm_example」の中の全てのフォルダーを「D:\embeded\eclipse\workspace」へコピーして

ください。
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5.2 Eclipse プラグイン(Zylin Embedded CDT)インストール 
＊Zylin Embedded CDT の 4.81 バージョンは Zylin のホームページから取り下げますので、 

弊社から圧縮ファイルをダウンロードしてから Eclipse にコピーしてください。 

＊Zylin Embedded CDT の最新版では検証していないため、インストールしないでください。 

 

Zylin Embedded CDT ダウンロード URL： 

http://www.dragonwake.com/download/open-jtag/com.zylin.embeddedcdt_4.8.1.zip 

 

上記ファイルを解凍し「Eclispe インストール先」の「plugins」というフォルダーにコピーしてください。 

コピーが完了したら、Eclipse を再起動させます。 
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5.3 ビルドの設定 
Eclipse の"Window"→"Preferences"を選択し、 

Preferences の"C/C++ Build"→"Settings"を選択し"Binary Parsers"タブの"GNU Elf Parser"にチェックを入れて OK ボタンを押

します 
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5.4 OpenOCD の設定 
１．Eclipse の"Run"→"External Tools."→"External Tools Configrurations..."を選択します。 
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２．External Tools Configrurations の"Program"を右クリックし、"New"を選択します。 
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３．Main タブの"Name"に適当な名前を入力してください、例えば、”OpenOCD"。 

"Location:"に"D:\embeded\openocd\bin\openocd.exe"、 

"Working Directory:"に" D:\embeded\eclipse\workspace " 

"Arguments:"に-f "D:\embeded\elipse\worksapce\config\interface\open-jtag.cfg"  

-f "D:\embeded\elipse\worksapce\config\target\lpc2388.cfg"と入力します。 

＊基板種類（lpc2148,lpc2388,mini2440 など）により、Arguments の設定も異なる。 
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Build タブをクリックし"Build before launch"にチェックを外れます。全てを入力し終えたら"Apply"ボタンを押し、"Close"ボタンを

押します。 
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5.5 Cygwin のソース・ルックアップ・パスの設定 
GDBでデバッグを開始すると「Can't find a source file at "/cygdrive/c/project/hoge/hoge.cpp"」なんて怒られる。Cygwinのパス

を eclipse が認識できていない様 子。この場合は、ルックアップ・パスの設定が必要。 

eclipse のメニュー[ウィンドウ]→[設定]で設定ダイアログを開き、[C/C++]→[Debug]→[Common Source Lookup path]にルッ ク

アップ設定を追加する。 
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「Path Mapping」を選択、「OK」を押下 

 

 
「Add」をクリック、「Compilation path」に「/cygdrive/c/」、「Local file system path」に「c:/」を指定する。 
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「Add」をクリック、他のローカルドライブを同じように追加する。最後、「OK」ボタンを押下 
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5.6 Eclipse デバッグ用のコマンド及びショットカットキー一覧 
詳しくは Eclipse に関わるドキュメントを参照 

 

 
ステップ実行において良く使われる操作の一覧を以下に示します。 

  

操作名 ショートカットキー 

再開 F8 

ステップイン F5 

ステップオーバー F6 

ステップ・リターン F7 

  

  

ステップ実行とは関係ありませんが、前回起動したクラスを再度実行したりデバッグする場合

は、以下のショートカットキーが便利です。 

  

操作名 ショートカットキー 

前回の起動を実行 Ctrl + F11 

前回の起動をデバッグ F11 
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第六章 ARM シリーズデバッグ手順 
＊本書に使われる ARM シリーズは全て弊社の製品となります。 

詳しくは弊社の通販サイト：http://www.csun.co.jp までにご参照ください。 

第四章「インストール手順」、第五章「Eclipse の設定」に従って行っていれば、ARM シリーズ、例えば、ARM7（LPC2148、

LPC2388）、Contex-M3（STM32F103）、ARM9(MINI2440)のサンプルを導入のうえ、デバッグ手順を説明させて頂きます。 

6.1 ARM7 の LPC2148 
6.1.1 LPC2148 ボード購入 URL 
http://www.csun.co.jp/SHOP/2009071209.html 
ボード URL から LPC2148 マニュアルを参照し、Open-JTAG に接続してください。 
LPC2148 マニュアルダウンロード URL： 
http://www.dragonwake.com/download/LPC2148/LPC2148_manual.pdf 
6.1.2 ハードウエア動作確認 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
１．OpenJTAG をパソコンの USB ポートに挿入する 

２．JTAG ケーブルで OpenJTAG と LPC2148 ボードを繋ぐ 

３．LPC2148 ボードに電源を入れる 

４．下記のコマンドを入力します。 

openocd -f "D:\embeded\eclipse\workspace\config\interface\open-jtag.cfg" -f 

"D:\embeded\eclipse\workspace\config\target\lpc2148.cfg" 

はじめの-f は OpenJTAG のコンフィグファイルを使います。二番目の-f は lpc2148 のコンフィグファイルを使います。 

JTAG ポート 

Open-JTAG 

USB シリアル

ケーブルとし

て使えます。 
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6.1.3 LPC2148 用のサンプル「LED」をデバッグ 
サンプルダウンロード URL： 
http://www.dragonwake.com/download/LPC2148/Example-2148GCC.rar 
*サンプルの導入について、二つ方法があります、一つは新規プロジェクトを作成してからソースを導入、もう一つは

ダウンロードプロジェクトをインポートします。 
＊ここに新規プロジェクトの作成として説明 
１．プロジェクト「LPC2148_LED」を作る 

a)新規プロジェクトを作成するため"File"→"New"→"C Project"を選択します 
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b)適当なプロジェクト名前(LPC2148_LED)を入力し Finish ボタンを押します。 

 
 

http://www.csun.co.jp/�


株式会社日昇テクノロジー 
 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp 50 

c)サンプルソースを作成されたプロジェクトにインポート 

 Project Explorer の「LPC2148_LED」を選べ、右クリックし、「Import」を押下 
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d)「File System」を選択し、「Next」をクリック 
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e) ダウンロードしたサンプル LPC2148_LED を選択 
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ｆ）ソースファイルと Makefile を導入 
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ｇ）共通のソースも導入（他の操作は上記 c）、d）と同じ） 
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h)サンプル LPC2148_LED をビルド 
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i)ビルドエラーメッセージ（エラーメッセージがなければ、i）を飛ばして j)を直接参照） 
「make: *** No rule to make target `../common/src/startup.c', needed by `depend'.  Stop.」 
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j)「common」こういうソースのパスを「Makefile」に修正 
「Edit」→「Find/Replace」 
「Find」：「../common」を入力、「Replace with」：「./common」を入力、「Replace All」をクリック 
置き換えの後、「File」→「Save」をクリック 
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k)修正後、再度ビルド（赤丸に囲まれるメッセージが出てきれば、ビルドが成功ということを判明） 
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２．openocd 設定の修正 

一般の設定は「5.4 OpenOCD の設定」を参照 

   a)「Working Directory」を「LPC2148_LED」に変更 

    b) 「Arguments」を下記のように変更 

-f "D:\embeded\eclipse\workspace\config\interface\open-jtag.cfg"  -f 

"D:\embeded\eclipse\workspace\config\target\lpc2148.cfg" 
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３．LPC2148_LED 用の GDB を追加 

a)アイコン「Debug」をクリック、「Debug Configuration」を押下 
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b) 「Zylin Embedded debug(Cygwin)」を右クリック、「New」を選択 
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c)「Name」」を入力、「Project」、「C/C++ Application」（elf ファイル指定）を指定 
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d) 「GDB debugger」を「arm -elf-gdb.exe」の場所に指定 
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e) 「Commands」を入力（//の右はコメントです、Eclipe にコピーしないでください。） 
target remote localhost:3333 // ローカルポート「3333」と接続（OpenOCDと接続） 

monitor halt//ボードの実行を中断させる 

monitor step//ステップで実行するように 

load // leds_elfをロード，「elf」というフォーマットのファイルにアドレスを含まれる 

break main // 「main」関数にブレークポイントを設定 

continue // プログラムを実行させて、「main」にとまってステップでデバッグ可能 
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４．デバッグ 
a) OpenOCD を起動 
External Tools の▼ボタンをクリックし、OpenOCD を選択 

 
 

b)Console ウインドに下記のメッセージが出力 

 
 

c)Debug の▼ボタンをクリックし、"LPC2148_LED"を選択。 
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d)「main」関数に止まる 
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e) ブレークポイントでプログラムが中断した状態から、次のブレークポイントまで実行させたり、1 行ずつ実行させた

りできます。コードを繰り返して実行することにより、LED ランプが点滅します。 
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５．デバッグ終了 
a) gdb の停止 

  Debug ウインドウの gdb の Thread を選択し、停止ボタンと押します 

 
 

b) OpenOCD の停止 
  Debug ウインドウの OpenOCD の Thread を選択し、停止ボタンと押します 

 
c) 電源停止 

  ターゲットの電源を停止 
 

d) OpenJTAG をターゲットから取り外す 
 

e) 上記が面倒であれば Eclipse を終了しターゲットの電源停止、open-JTAG を取り外しでも OK です。 
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6.2 ARM7 の LPC2388 
6.2.1 LPC2388 ボード購入 URL 
http://www.csun.co.jp/SHOP/200903021.html 
ボード URL から LPC2388 マニュアルを参照し、Open-JTAG に接続してください。 
LPC2338 マニュアルダウンロード URL： 
http://www.dragonwake.com/download/LPC2388/LPC2388_manual.pdf 
6.2.2 ハードウエア動作確認 

 
 
(1). OpenJTAG をパソコンの USB ポートに挿入する 
(2). JTAG ケーブルで OpenJTAG と LPC2388 ボードを繋ぐ 
(3). LPC2388 ボードに電源を入れる 
(4). 下記のコマンドを入力します。 
openocd -f " D:¥embeded¥eclipse¥workspace¥config¥interface¥open-jtag.cfg" -f " 
D:¥embeded¥eclipse¥workspace¥config¥target¥lpc2388.cfg" 

※ はじめの-f は OpenJTAG のコンフィグファイルを使います。二番目の-f は lpc2388 のコンフィ

グファイルを使います。 

(1) 

(2) 

(3) 
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画面のように"Info : JTAG Tap/device matched"と表示されればＯＫです 
（この時点で ARM LPC2388 と通信が出来ています） 
 
(6). その後 CTRL+C を押してデバッグを中止します。 
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6.2.3 LPC2388 用のサンプル「LED」をデバッグ 
*サンプルの導入について、二つ方法があります、一つは新規プロジェクトを作成してからソースを導入、もう一つは

ダウンロードプロジェクトをインポートします。 
＊新規プロジェクトの作成方法は「6.1.3 LPC2148 用のサンプル「LED」をデバッグ」を参照 
＊ここに既存プロジェクトのインポートとして説明 
１．プロジェクト導入：「File」→「Import」→「Existing Projects into workspace」 
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既にダウンロードしたプロジェクトを Workspace に入れていますので、ここに「Copy projects into workspace」を外

します。Workspace に入れていない場合、「Copy projects into workspace」をチェックしてください。 
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２．導入済みのプロジェクトをコンパイル 

「LPC2388_LED」を選択、「Project」→「Build Project」を押下 

 
コンパイルが成功すれば、実行ファイルLPC2388_LED_rom.elfとLPC2388_LED_rom.hexを生成されます。  
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３．openocd 設定の修正 
一般の設定は「5.4 OpenOCD の設定」を参照 

   a)「Working Directory」を「LPC2388_LED」に変更 
    b) 「Arguments」を下記のように変更 

-f "D:¥embeded¥eclipse¥workspace¥config¥interface¥open-jtag.cfg" -f 
"D:¥embeded¥eclipse¥workspace¥config¥target¥lpc2388.cfg" 
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４．LPC2388_LED 用の GDB を追加 
①アイコン「Debug」をクリック、「Debug Configuration」を押下 
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②「Zylin Embedded debug(Cygwin)」を右クリック、「New」を選択 

 

http://www.csun.co.jp/�


株式会社日昇テクノロジー 
 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp 78 

 

③「Name」」を入力、「Project」、「C/C++ Application」（elf ファイル指定）を指定 
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④「GDB debugger」を「arm -elf-gdb.exe」の場所に指定 
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⑤「Commands」を入力 
target remote localhost:3333 // ローカルポート「3333」と接続（OpenOCDと接続） 

monitor halt//ボードの実行を中断させる 

monitor step//ステップで実行するように 

load // leds_elfをロード，「elf」というフォーマットのファイルにアドレスを含まれる 

break main // 「main」関数にブレークポイントを設定 

continue // プログラムを実行させて、「main」にとまってステップでデバッグ可能 

「LPC2388_LED」プロジェクトの配下、「gdb.cmd」ファイルの内容をそのままコピーしても OK 

「gdb.cmd」を右クリック、「Open With」→「Text Editor」 

＊ほかの設定を保存するため、コピー途中で「Apply」ボタンを押して適用します。 
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上記のコピー内容を下記「Commands」に貼り付け、「Apply」ボタンを押下 
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５．デバッグ 
① openocd 起動 
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② gdb 起動 

アイコン「Debug」をクリックし、「LPC2388_LED」を押下 
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③ 関数「main」に止まり、ショットカットキー「F6」でステップでデバッグできる 
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6.3 ARM Cotex-M3 の STM32F103 
6.3.1  STM32F103 ボード購入 URL 
http://www.csun.co.jp/SHOP/200903019.html 
ボード URL から STM32F103 マニュアルを参照し、Open-JTAG に接続してください。 

ボード URL から LPC2388 マニュアルを参照し、Open-JTAG に接続してください。 
STM32F103 ボードマニュアルダウンロード URL： 
http://www.dragonwake.com/download/download-stm32/STM32_manual.pdf 
6.3.2 ハードウエア動作確認 
(1). OpenJTAG をパソコンの USB ポートに挿入する 
(2). JTAG ケーブルで OpenJTAG と STM32 ボードを繋ぐ 
(3). STM32 ボードに電源を入れる 
(4). 下記のコマンドを入力します。 
openocd -f "D:\embeded\eclipse\workspace\config\interface\open-jtag.cfg" -f 

"D:\embeded\eclipse\workspace\config\target\stm32.cfg" 

※ はじめの-f は OpenJTAG のコンフィグファイルを使います。二番目の-f は stm32 のコンフ

ィグファイルを使います。 

 
 

http://www.csun.co.jp/�
http://www.csun.co.jp/SHOP/200903019.html�
http://www.dragonwake.com/download/download-stm32/STM32_manual.pdf�


株式会社日昇テクノロジー 
 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  86 

6.3.3 LED サンプルデバッグ 
*サンプルの導入について、二つ方法があります、一つは新規プロジェクトを作成してからソースを導入、もう一つ

はダウンロードプロジェクトをインポートします。 
＊新規プロジェクトの作成方法は「6.1.3 LPC2148 用のサンプル「LED」をデバッグ」を参照 
＊ここに既存プロジェクトのインポートとして説明 
１．プロジェクト導入：「File」→「Import」→「Existing Projects into workspace」 
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既にダウンロードしたプロジェクトを Wokspace に入れていますので、ここに「Copy projects into workspace」を

外します。 
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２．導入済みのプロジェクトをコンパイル 
「STM32_LED」を選択、「Project」→「Build Project」を押下 
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３．openocd 設定の修正 
一般の設定は「5.4 OpenOCD の設定」を参照 

   a)「Working Directory」を「STM32_LED」に変更 
    b) 「Arguments」を下記のように変更 

-f "D:¥embeded¥eclipse¥workspace¥config¥interface¥open-jtag.cfg" -f 
"D:¥embeded¥eclipse¥workspace¥config¥target¥stm32.cfg" 
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４．STM32_LED 用の GDB を追加 
①アイコン「Debug」をクリック、「Debug Configuration」を押下 
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②「Zylin Embedded debug(Cygwin)」を右クリック、「New」を選択 
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③「Name」」を入力、「Project」、「C/C++ Application」を指定 
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④「GDB debugger」を「arm-none-eabi-gdb.exe」の場所に指定 
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⑤「Commands」を入力 
target remote localhost:3333 // ローカルポート「3333」と接続（OpenOCDと接続） 

monitor halt//ボードの実行を中断させる 

monitor step//ステップで実行するように 

load // leds_elfをロード，「elf」というフォーマットのファイルにアドレスを含まれる 

break main // 「main」関数にブレークポイントを設定 

continue // プログラムを実行させて、「main」にとまってステップでデバッグ可能 

「STM32_LED」プロジェクトの配下、「gdb.cmd」ファイルの内容をそのままコピーしても OK 

「gdb.cmd」を右クリック、「Open With」→「Text Editor」 

＊ほかの設定を保存するため、コピー途中で「Apply」ボタンを押して適用します。 
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上記のコピー内容を下記「Commands」に貼り付け、「Apply」ボタンを押下 
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５．デバッグ 
① openocd 起動 

 

http://www.csun.co.jp/�


株式会社日昇テクノロジー 
 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  98 

② gdb 起動 
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③ 関数「main」に止まり、ショットカットキー「F6」でステップでデバッグできる 
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④ ステップでデバッグ 
 ＊関数「main」のコーディング「GPIO_SetBits(GPIOB, GPIO_Pin_5);」を実行前、 

要は、LED 点灯前に、STM32 ボードの LED が消している 

 
 
ショットカットキー「F6」を押しながら、関数「main」のコーディング「GPIO_SetBits(GPIOB, GPIO_Pin_5);」
を実行後、SMT32 ボードの LED が点灯している 
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6.4 ARM9 の MINI2440 
6.4.1 MINI2440 を購入 
MINI2440 ボード購入 URL：（LCD3.5 とのセット） 
http://www.csun.co.jp/SHOP/200812021.html 

LPC2148 マニュアルダウンロード URL： 
http://www.dragonwake.com/download/arm9-download/linux-2.6.29/MINI2440-linux-2.6.29.pdf 

6.4.2 ハードウエア動作確認 
１． OpenJTAG をパソコンの USB ポートに挿入する 

２．JTAG ケーブルで OpenJTAG と MINI2440 ボードを繋ぐ 

３．MINI2440 ボードに電源を入れる 

４．下記のコマンドを入力します。 

openocd -f "D:\embeded\eclipse\workspace\config\interface\open-jtag.cfg" -f 

"D:\embeded\eclipse\workspace\config\target\mini2440.cfg" 

※ はじめの-f は OpenJTAG のコンフィグファイルを使います。二番目の-f は mini2440 のコンフィグフ

ァイルを使います。 
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6.4.3 LED サンプルデバッグ 
１．サンプルの導入とコンパイル： 
サンプルの導入について、二つ方法があります、一つは新規プロジェクトを作成してからソースを導入、 
もう一つはダウンロードプロジェクトをインポートします。 
＊ここに新規プロジェクトの作成方法として説明 
①プロジェクト「MINI2440_LED」を作る 
a) 新 規 プ ロ ジ ェ ク ト を 作 成 す る た め "File"→"New"→"C Project" を 選 択 し ま す
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b)適当なプロジェクト名前(MINI2440_LED)を入力し Finish ボタンを押します。 
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c)サンプルソースを作成されたプロジェクトにインポート 

 Project Explorer の「MINI2440_LED」を選べ、右クリックし、「Import」を押下 
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d)「File System」をクリック 
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e) ダウンロードしたサンプル MINI2440_LED を選択 
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ｆ）選択したソースを導入 

（新規プロジェクトなので、既存プロジェクトの設定ファイル「.cproject」と「.project」のチェックを外す） 
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g)サンプル MINI2440_LED をビルド 
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h)ビルドが成功かどうかを確認 
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２．サンプル MINI2440_LED をデバッグ 

①MINI2440 用の OpenOCD デバッグパラメタを設定 
＊ OpenOCD の設定は「5.4 OpenOCD の設定」（P23～P26）を参照 
a) MINI2440 用のコンフィギュレーションファイル内容を確認 

「config/interface」の中：JTAG の種類によるコンフィギュレーションファイル 
Open-JTAG 用のンフィギュレーションファイル：「open-jtag.cfg」 
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b) config/target」の中：CHIP に関わるコンフィギュレーションファイル 
MINI2440 ボード用のンフィギュレーションファイル：「Mini2440.cfg」 
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ｃ） OpenOCD の設定画面を呼び出す 
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d) 「Location」、「Working Directory」、「Arguments」を設定 

＊特に「Arguments」に MINI2440 用のコンフィギュレーションファイルを設定必要 

-f D:\embeded\eclipse\workspace\config\interface\open-jtag.cfg 

-f D:\embeded\eclipse\workspace\config\target\Mini2440.cfg 
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e) OpenOCD の起動が成功かどうかを確認 
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 ②MINI2440 用のデバッグを設定 

  a)デバッグ設定画面を呼び出す 
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b)「Zylin Embedded debug(Cygwin)」を選べ、右にクリックしてから「New」を押下 
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c)デバッグ設定画面の中、「Main」タブ項目を設定 
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d)「Commonds」タブ項目を設定（//の後にはコマンドのコメントとなり、設定内容に入れない） 
target remote localhost:3333 // ローカルポート「3333」と接続（OpenOCDと接続） 

monitor halt//ボードの実行を中断させる 

monitor arm920t cp15 2 0 // MMU機能をクローズ 

monitor step//ステップで実行するように 

load // leds_elfをロード，「elf」というフォーマットのファイルにアドレスを含まれる 

break main // 「main」関数にブレークポイントを設定 

continue // プログラムを実行させて、「main」にとまってステップでデバッグ可能 

 

「MINI2440_LED」プロジェクトの配下、「gdb.cmd」ファイルの内容をそのままコピーしても OK 

「gdb.cmd」を右クリック、「Open With」→「Text Editor」 

＊ほかの設定を保存するため、コピー途中で「Apply」ボタンを押して適用します。 
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③ OpenOCD を起動させる 
a)「Exteral Tools」をクリックし、openocd を押下 
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b)成功に起動したことを確認 
 

 

http://www.csun.co.jp/�


株式会社日昇テクノロジー 
 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  121 

④ Debug ツール「gdb」が起動前、ARM9 ボードの様子 
a) ４LED が全て消している 
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⑤ Debug ツール「gdb」を起動させる 
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⑥ ウインドに関数「main」の一番最初に止まっている 
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⑦ ステップ実行して Debug（ショットカットキーF6） 
a) ブレークポイントでプログラムが中断した状態から、次のブレークポイントまで実行させたり、1行ずつ実

行させたりできます。 
コード「GPBDAT = (~(i<<5))」を繰り返して実行することにより、 
LEDランプが１つずつ点滅 
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b)Debug 途中の ARM9 ボードの様子の１（一番右の LED ランプが点灯） 
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c)Debug 途中の ARM9 ボードの様子の２（右から 2 番目の LED ランプが点灯） 
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⑧ Debug を停止する（gdb、openocd をそれぞれ選択し「■」をクリック） 
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6.4.4 u-boot サンプルデバッグ 
１．サンプルの導入 
①プロジェクト「MINI2440_u-boot」を作る 

作成方法は「4.4.3 LED サンプルデバッグ」の「①プロジェクト「MINI2440_LED」を作る」を参照 

 

メモ： 

   a)u-boot のソースコードを Windows 上にコンパイルできないので、コンパイル後のファイルを提供 

   b)自分のソースをコンパイル場合、下記の 2 点修正が必要 
    #define CONFIG_SKIP_LOWLEVEL_INIT 1 /* SDRAMの初期化を行わない */ 

#define CONFIG_SKIP_RELOCATE_UBOOT 1 /*実行アドレスをロードされるため、再配置必要なし*/ 

作成されたプロジェクトフォルダー構成： 

(ア) コンパイル後のファイル：u-boot は elf ファイルとなる 

(イ) デバッグ用の u-boot ソース 

(ウ) 「init」初期化用のファイル（u-boot は SDRAM に実行されるため、初期化必要） 

 

（ii） （iii） 

（i） 
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２．サンプル MINI2440_u-boot をデバッグ 

 他の設定は MINI2440_LED と同じですので、違い設定のみを説明 
① openocd 設定 
「Working Directory」を「MINI2440_u-boot」に変更 
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② MINI2440_u-boot 用の GDB を追加 
＊追加方法は「MINI2440_LED」の GDB と同じです。 
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③デバッグ用のコマンドを設定（//はコメント内容となり、実際の設定に入れないでください。） 

target remote localhost:3333 // ローカルポート「3333」と接続（OpenOCDと接続） 

monitor halt//ボードの実行を中断させる 

monitor arm920t cp15 2 0 // MMU機能をクローズ 

monitor step//ステップで実行するように設定 

monitor load_image D:\\embeded\\eclipse\\workspace\\mini2440\\MINI2440_u-boot/init/init.bin 0x0 

//u-boot は SDRAM に実行されるため、初期化実行モジュールをロード（実際の init パスを入力） 

monitor resume 0x0//初期化モジュールを実施 

monitor halt//ボードの実行を中断させる 

load//u-boot をロード 

break start_armboot//「start_armboot」関数にブレークポイントを設定 

continue// プログラムを実行させて、「start_armboot」にとまってステップでデバッグ可能 
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④デバッグ 

a) openocd 起動 
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b) gdb 起動 

 関数「start_armboot」に止まり、ショットカットキー「F6」でステップでデバッグできる 
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c) ステップでデバッグ 

コーディング「hang()」を実行したら、MINI2440 ボードからベルを鳴る 
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